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Was kann Blender

Blender ist ein leistungsstarkes Open-Source 3D- Bearbeitungs- und Modellierungsprogramm und bringt folgende Funktionen mit:

• 3D Modelle modellieren und rendern
• Animationen erstellen
• Bringt Videoschnitteditor mit 
• Besitzt Eingebaute Spiel-Engine
• Als Portable-Version verfügbar

Blender besitzt eine große Entwickler-Community, die den Funktionsumfang stetig erweitert. Aufgrund der GPL stet das Programm für alle gängigen 
Betriebssysteme (Windows, Linux, Mac OS X) zur Verfügung. 

Programmiersprachen:
• Python (hauptsächlich)
• C
• C++

Unterstütze Dateiformate:
• Bilder: 

JPEG, JPEG2000, PNG, TARGA, OpenEXR, DPX, Cineon, Radiance HDR, SGI Iris, TIFF
• Video: 

AVI, MPEG, Quicktime
• 3D: 

3D Studio (3DS), COLLADA (DAE), Filmbox (FBX), Autodesk (DXF), Wavefront (OBJ), DirectX (x), Lightwave (LWO), Motion Capture (BVH), SVG, Stanford 
PLY, STL, VRML, VRML97, X3D, glTF.

(Source: http://www.blender.org)
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Anwendungsgebiete

Modellierung

Blender bietet die Möglichkeit schnelle, realistische und detailgetreue Modelle zu erstellen. 

Blender bietet hierfür folgende Features:

•Vorschau in Echtzeit

•HDR lighting support

•Engine für verschiede Materialien (z.B. Glas)

•Engine für Schatten, Pflanzen, Wolken, Gelände etc.

•Toolbox für 3D Druck

Laterne in Blender 
modelliert

(Source: 
http://www.blender.org/wp-
content/uploads/2012/11/ma
terials_screenshot.png
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Anwendungsgebiete

Animationen

2006 erschien Elephants Dream , der erste Film, der allein durch den Einsatz von Blender realisiert wurde. 

Dementsprechend bietet Blender auch hier eine Reihe von Features:

• Leistungsstarkes Rigging-Tool (Skelett für Bewegungen)

•Animation pose editor

• Sound synchronization

•Unterstützt non linear animation (NLA)

• Sculpting

• Simulationen für 

• Flüssigkeiten

• Rauch

• Haare

• …

•…
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Source: http://www.blender.org/features/
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Blender-Erweiterung um STEP-Import

Info: https://blenderartists.org/t/step-import/1203804

Benötigt Windows 10+, 64-bit, Blender 2.8+ with Python 3.7+
(+ oder neuer)

Download für € 17 unter https://ambient.gumroad.com/l/stepper

In Blender importieren:

1. Bearbeiten → Einstellungen →
Importieren → ZIP-Datei

2. Unter Add Ons findet sich 
dann der Eintrag . Aktiviert wird
mit dem Haken vor Import: 

https://blenderartists.org/t/step-import/1203804
https://ambient.gumroad.com/l/stepper
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Benutzeroberfläche
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Viewport

Timeline

Properties
Objektliste
(Outliner)
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Benutzeroberfläche (A)
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Benutzeroberfläche (B)

Einstellungen, um in der Bearbeitungsansicht die 
Materialien zu sehen.
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Benutzeroberfläche (C)

Zu hoch aufgelöste Darstellung, die zu sehr großen

Datenmengen führt wieder zurückstellen.

Objekt markieren

Modifier Properties auswählen.

Decimate > Un-Subdivide > Iterations > 5 > Enter

> Apply
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Bedienung

Blender besitzt durch den großen Funktionsumfang eine komplexe Struktur. 

Blender ist darauf ausgelegt, mit Short-Cuts zu arbeiten. Die wichtigen Befehle sind:

Taste Funktion

Linke Maustaste Befehle / Programmteile auswählen / 
3D-Curser setzten

Rechte Maustaste Objekte auswählen/verschieben/ 
Befehl abbrechen

Mittlere Maustaste / Mausrad Ansicht verändern

CTR+ Z zurück

A Alle Objekte auswählen

B Bereich wählen

F Fläche erstellen
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Bedienung

Blender besitzt durch den großen Funktionsumfang eine komplexe Struktur. Blender ist darauf ausgelegt, mit 
Short-Cuts zu arbeiten. Die wichtigen Befehle sind:

Taste Funktion

Shift + D Objekt duplizieren

R Rotieren (RR alle Achsen)

Tab Zwischen Edit Mode und Normaler 
Ansicht wechseln

Shift + A Kontextmenü für neue Objekte

Strg LMT Bereich aufziehen, um alle Objekte
auszuwählen



Grundlagen der Modellierung
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Beispiel 1: Ring modellieren

1. Setzen Sie den 3D-Curser in den 
Koordinatenursprung. 

2. Drücken Sie Shift + A > Mesh und 
erstellen sie einen Kreis oder klicken Sie im 
Menü links unter dem Viewport auf add→
Mesh→ Circle.

3. Wechseln Sie in den Edit Mode. 

4. Um einen Ring zu zeichnen, müssen wir 
aus dem Kreis eine Fläche erzeugen.
Klicken Sie hierfür auf die Taste e
(Extrude) und anschließend die 
Taste s (Scale). 

5. Bewegen Sie die Maus, um eine 
Fläche zu erzeugen. Bestätigen Sie durch 
einen Klick mit der Linken Maustaste.
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Beispiel 1: Ring modellieren

6. Klicken Sie die Taste a, um die komplette 
Fläche auszuwählen. Alternative: Mit der 
gedrückten linken Maustaste ein Rechteck 
um das Objekt ziehen. 

7. Klicken Sie anschließend die Taste e. Eine 
blaue Linie (Z-Achse) erscheint.

8. Bewegen Sie die Maus nach oben, um einen 
eckigen Ring zu erhalten.

9. Bestätigen Sie durch einen Klick mit der
Linken Maustaste.
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Beispiel 1: Ring modellieren

10. Bewegen Sie Ihre Maus auf den oberen 
Bereich des Rings.

11. Drücken Sie STR + R, um einen Loop Cut zu 
erstellen. Alternativ: Transformations-
werkzeug. 

12. Klicken Sie die linke Maustaste. 

13. Wählen Sie am linken Rand das 
Transformationswerkzeug aus. 
Shortcut: Shift Spacebar , G

14. Verschieben Sie die Z-Achse (blauer Pfeil) im 
Koordinatenkreuz mit gedrückter linker 
Maustaste nach oben, um eine Erhebung zu 
erzeugen.

15. Wiederholen Sie diesen Vorgang auf der 
Unterseite des Rings. 
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Beispiel 1: Ring modellieren

Um die Unterseite des Ringes zu bearbeiten, muss er gedreht werden. 

15. Drehen Sie die gesamte Darstellung mit gedrückter mittlerer Maustaste um 180 Grad.

17. Bewegen Sie Ihre Maus auf den oberen Bereich des Rings.

18. Drücken Sie STR + R, um einen Loop Cut zu erstellen. Alternativ: Transformationswerkzeug. 

19. Klicken Sie die linke Maustaste.

20. Wählen Sie am linken Rand das Transformationswerkzeug aus. 
Shortcut: Shift Spacebar , G   Alternativ: Transformationswerkzeug Pfeilbutton.  

21. Verschieben Sie die Z-Achse (blauer Pfeil) im Koordinatenkreuz in entgegen der Pfeilrichtung, 
um eine Erhebung zu erzeugen.

Der Ring ist nun noch etwas eckig. Jetzt beginnt das Fein-Tuning.
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Beispiel 1: Ring modellieren

Um uns mit weiteren Funktionen vertraut zu machen, 
wechseln wir nun die Ansicht.
Blender rendert alle Objekte aus der Sicht einer
Kamera. 
22. Klicken Sie im Zahlenblock auf die Taste 0, 

um in die Kameraansicht zu gelangen.
23. Zoomen Sie ggf. mithilfe des Mausrad hinein.
24. Klicken Sie die Taste a, so dass der Ring 

vollständig ausgewählt ist. Er wechselt dabei
seine Farbe von grau zu orange. Dabei muss der 
Maus-Cursor im Arbeitsbereich sein!

25. Es erscheinen die Koordinaten-Achsen. Fahren 
Sie mit dem Maus-Cursor über eine Achse.

26. Drücken Sie die Taste R, um den Ring um eine 
Achse zu drehen. RR, um alle Achsen zu 
drehen. Bestätigen Sie mit der linken Maustaste.

27. Wiederholen Sie den Vorgang für mehrere 
Achsen, bis der Ring gut zu sehen ist.
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Beispiel 1: Ring modellieren

28. Wechseln Sie in den Object Mode und wählen Sie
unter dem Object-Button Shade Smooth aus. 
Der Ring wird abgerundet.

29. Drücken Sie die Taste F12, um das gerenderte 
Objekt anzusehen.

30. Klicken Sie auf die Taste ESC, um die Ansicht zu 
verlassen

31. Klicken Sie im Nummernblock die Taste 0, um die 
Kameraansicht zu verlassen.
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Beispiel 1: Ring modellieren

Um den Ring noch weiter abzurunden, widmen 
wir uns dem Kontextmenü am rechten 
Bildschirmrand. Im oberen Bereich befinden sich
alle Objekte unserer Scene. Darunter befindet sich
ein Modifikationsmenü.

32. Wählen Sie das Objekt Circle aus. 
(Unser Ring wurde aus einem Kreis erstellt)

33. Wählen Sie in den Properties das Menü
Modifier Properties.

34. Klicken Sie auf Add Modifier.

35. Wählen Sie Subdivision Surface.

→ Der Ring wird bereits etwas abgerundet.

Über Levels Viewport können Sie die Feinheit einstellen. Je größer der 
Wert, desto intensiver ist die Rechenoperation. Ein Wert zwischen 2 und 
4 ist optimal.

36. Klicken Sie auf Apply um die Einstellung zu übernehmen.
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Beispiel 1: Ring modellieren

Falls das Licht in der Render-Ansicht noch nicht 
ihren Wünschen entspricht, kann dies ebenfalls 
geändert werden.

37. Wählen Sie in ihrer Scene das Objekt Light 
aus und aktivieren Sie im Transformations-
fenster den Verschiebe-Button (Move).

38. Die Koordinaten-Achsen erscheinen.

39. Klicken Sie auf eine Achse und verschieben 
Sie die Lampe.

40. Wiederholen Sie den Vorgang, bis Sie 
zufrieden sind.

41. Unter Object Data Properties und Power
können sie die Leuchtstärke einstellen. 
Testen Sie das Render-Ergebnis mit F12.
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Beispiel 1: Ring modellieren

Geben wir dem Ring eine Farbe.

42. Wählen Sie in ihrer Scene das Objekt Circle aus.

43. Klicken Sie auf New.

44. Wählen Sie unter Properties Material aus.

45. Stellen Sie bei Base Color die Farbe auf rot.

46. Sehen Sie sich die Scene im Rendermode an F12. 
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Bedienung Kamera

Die wichtigen Kamera-Befehle sind:

Taste Funktion

NumPad 0 Kameraperspektive ein-/ausschalten

G Objekt in Kameraperspektive bewegen

N Öffnen der Kamera-Toolbar

Toolbar: View: Lock camera to view Objekt kann auch in Kamerapersp. 
bewegt werden

Shift + F Kamera in Normalansicht bewegen

RR Verschieben
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Beispiel 2: Eine Animation erstellen

1. Öffnen Sie die Datei Druckluft.blend unter File > Open.

2. Überlegen Sie sich, wie viele Sekunden Ihre Animation 
dauern soll. Achten Sie darauf, dass Blender die komplette 
eingestellte Zeit rendert, auch wenn ihr Animationsschritt 
schon nach einem Drittel der Zeit fertig ist. 

3. Stellen Sie Startzeit und Endzeit Ihrer Animation unter Frame 
Range ein.

→ Sie sehen die Änderung unten in der Timeline.



Hochschule Karlsruhe Technik & Wirtschaft Blender Prof. Dipl.-Ing. Martin Schober

Beispiel 2: Eine Animation erstellen

4. Ziehen Sie die blaue Markierung in der Timeline 
auf die von Ihnen gewünschte Startzeit.

5. Klappen Sie das Transform-Menü im Viewport 
aus (Taste t). Wählen Sie Move zum Verschieben 
in einer der Achsen aus.

6. Wählen Sie eine der vier oberen Schrauben des 
Druckluftmotors mit der linken Maustaste aus.

7. Sie sehen, dass das Koordinatensystem der 
Schraube außerhalb der Schraube liegt. Mit 
rechtem Mausklick auf die Schraube öffnen sie 
ein Fenster in dem Sie das Koordinatensystem 
mit Set Origin > Set Origin to Geometry in das 
Zentrum der Schraube setzen können. 
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Beispiel 2: Eine Animation erstellen

8. Mit der Taste I öffnen Sie das Menü Insert Keyframes. 
Mit einem Klick auf LocRotScale legen Sie den 
Keyframe in der Zeitleiste fest. 

Die Animation:
a) Aktivieren Sie die Schraube (LMT)
b) Setzen Sie den Zeitstrahl auf die gewünschte 

Startzeit (z. B. 0s)
c) Tippen Sie I und wählen Sie LocRotScale (Der Cursor 

muss sich dabei im Hauptfenster befinden)
d) Setzen Sie den Zeitstrahl auf die Endzeit (z. B. 30s)
e) Bewegen Sie die Schraube jetzt in die gewünschte 

Richtung
f) Danach tippen Sie I und wählen Sie LocRotScale
g) Jetzt testen Sie die Animation in dem Sie auf 

Abspielen klicken

9. Wiederholen Sie die Animation für die verbliebenen 3 
Schrauben.

Lichtquellen
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Beispiel 2: Eine Animation erstellen

10. Spielen Sie Ihre Animation ab und überprüfen Sie, ob alle 
Schrauben gleichzeitig nach oben fliegen.

11. Richten Sie die Kamera so aus, dass die komplette 
Animation im Sichtfeld ist 
(Mit 0 auf dem Nummernblock wechseln Sie in die 
Kameraansicht und zurück).

12. Fügen Sie über Add > Light > Area eine weitere Lichtquelle 
hinzu und richten Sie diese aus. 

13. Unter Object Data Properties können Sie die Intensität der 
Lichtquelle erhöhen.
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Beispiel 2: Eine Animation erstellen

14. Richten Sie das Licht so aus, dass die Animation 
optimal beleuchtet ist (Mit F12 wechseln Sie in die 
Render-Ansicht).

15. Nehmen Sie, je nach gewünschter Ausgabequalität und 
Dateigröße der Animation, die entsprechenden 
Einstellungen rechts in den Properties vor.

16. Geben Sie unter Output einen Dateipfad an, unter dem 
die Animation gespeichert werden soll.

17. Klicken Sie unter Render auf Render Animation.

18. Die Animation wird gerendert und abgespeichert.
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Beispiel 3: Mechanik-Animation

Modi

Object Mode:

Standardmodus, Objekt als Ganzes (oder Objektteile) rotieren, skalieren und die Position verändern.

Edit Mode:

Detailliertere Veränderungen als im Object-Mode durchführbar. Z.B. Kanten/Ecken/Flächen für Maschen, 
Kontrollpunkte für Kurven/Oberflächen.

Pose Mode:

Zum Transformieren einer Armatur. Position/Rotation und Skalierung der einzelnen Bones. Wechsel in den 
Pose-Mode nur möglich wenn ein Bone ausgewählt ist. 
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Beispiel 3: Mechanik-Animation

Skalieren eines Bones:

Taste S drücken (nicht gedrückt halten) → Maus bewegen, vergrößert/verkleinert den Bone

zum Bestätigen →LMT (Linke MausTaste)/ zum Wiederrufen → RMT (Rechte MausTaste)

Rotieren des Bones:

Taste R  drücken (nicht gedrückt halten) →Maus bewegen, rotiert in gewünschte Richtung

zum Bestätigen → LMT / zum Wiederrufen → RMT

Verschieben des Bones:

Taste T drücken → öffnet das Objekt Tools-Menü → Translate anklicken und die Maus bewegen → bewegt den 
Bone aus seiner Position heraus.

zum Bestätigen → LMT / zum Wiederrufen → RMT

Skalieren und Rotieren in einem:

Taste G drücken (nicht gedrückt halten) →Maus bewegen, skaliert und rotiert mit der Mausbewegung
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Beispiel 3: Animation mit Bones 

A) Erstellen einer runden Stange aus einem Würfel

1. Öffnen Sie eine neue Standarddatei mit Würfel mit Ctrl + N.

2. Verlängern Sie den Würfel um 6 Einheiten in Z-Richtung mit S + Z + 6 + Enter.

3. Wählen Sie den Edit-Mode aus (Menü über der Zeitleiste).

4. Segmentieren Sie das Objekt mit „Loop Cut and Slide“  Ctrl + R. Fahren Sie mit 
der Maus über das Objekt und suchen Sie den gelben ersten Schnitt. Bestätigen 
Sie den Schnitt mit der LMT. Sobald der Schnitt sichtbar ist, setzen Sie weitere 
Schnitte wie beschrieben. Nach 5 Schnitten bestätigen Sie den 
Vorgang mit Enter.     

5. Drücken Sie im rechten Menü unter dem Teilebaum die Schaltfläche
„Modifiers“ (Schraubenschlüssel). Wählen Sie unter „Add Modifier“
die Funktion „Subdivision Surface“ aus. Erhöhen Sie unter 

„Levels Viewport“ die Segmentierung auf 3.

6. Mit der Auswahl „Loop Cut and Slide + Ctrl R“ und dem Verschieben 
der äußeren Schnitte können Sie, bei gedrückter linker Maustaste, den 
Radius an den beiden Endsegmenten  verkleinern.  
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Beispiel 3: Animation mit Bones 

Oder alternativ über die 
Menüs: 
Im nächsten Schritt 

verwenden wir den 

Befehl „Loop Cut“ zur

Unterteilung des Objekts.

Shortcut: Shift Spacebar

und Ctrl + R.
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Beispiel 3: Animation mit Bones

B) Erstellen der Bone-Struktur zum Verbiegen des Objekts 

1. Wählen Sie den Object-Mode aus (Menü über der Zeitleiste) 

und stellen Sie die Ansicht wireframe (Shift + Z) ein, damit die 

Bones gut sichtbar sind.

2. Über Object Mode und Add → Armature fügen Sie den ersten 

Bone ein. Evtl. muss der Bone über die X-, Y- und Z-Koordinate 

in die Mitte des Objektes positioniert werden. 

3. Mit S + 6 + Enter wird der Bone auf die Hälfte der Größe des 

Objektes gesetzt.

4. Die Verschiebung an das untere Ende geschieht mit G + Z + -6 

+ Enter.

5. Wählen Sie den Edit-Mode aus (Menü über der Zeitleiste).

6. Mit E + Z  + 6 erzeugen Sie einen zweiten Bone (Child) aus 

dem ersten Bone.
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Beispiel 3: Animation mit Bones

7. Die Verbindung der Stange mit den Bones wird wie 

folgt hergestellt: Umschalten in Object-Mode. Stange 

aktivieren. Im rechten Menü „Modifiers“ aktivieren 

und Add Modifiers → Armature auswählen. 

8. Im rechten Menü sind bei „Bind to:“ die „Bone

Envelopes“ anzuklicken und unter Object das kleine 

Viereck anzuklicken. Im aufgehenden Fenster dann 

Armature auswählen. Achten Sie darauf, dass unter 

„Object“ die richtige Armature eingetragen ist. 

9. Durch die Aktivierung des oberen Bones und der 

Auswahl des Pose-Mode, kann die Verbiegung durch 

das Bewegen des oberen Bones simuliert werden. Mit 

gedrückter linker Maustaste können Sie den oberen 

Bone rotieren und die Stange verbiegt sich.
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Beispiel 3: Animation mit Bones

C) Erzeugen der Animation des Biegevorgangs

1. Wählen Sie den „Pose-Mode“ aus.

2. Stellen Sie die Zeitleiste bei „End:“ auf 100 Frames ein. 

3. Verschieben Sie den Zeitstrahl auf den Frame 1, klicken Sie die 

Taste I und wählen sie LocRotScale im Menü aus. Dadurch 

setzen Sie den ersten Keyframe.

4. Verschieben Sie den Zeitstrahl auf einen gewünschten Frame, 

z.B. 50.

5. Rotieren Sie den oberen Bone um eine Achse, klicken Sie die 

Taste I und wählen sie LocRotScale im Menü aus. Dadurch 

setzen Sie den zweiten Keyframe.

6. Spielen Sie die Animation ab.

7. Verbiegen Sie die Stange um eine weitere Achse. 
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Beispiel 3: Animation mit Bones

D) Erzeugen eines Films aus der Animation des 

Biegevorgangs

1. Rendern Sie einen Film in der Größe 

640x480 Pixel im mp4-Format.

2. Öffnen Sie die „Render Presets“, durch einen 

Klick auf das Icon im rechten Menü. Stellen 

Sie die Größe, das Dateiformat (H.264) und 

die Dateiendung (MPEG-4) ein.

3. Richten Sie die Kamera so aus, dass das 

gesamte Modell innerhalb der Filmgrenzen 

liegt.

4. Rendern Sie den Film.
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Beispiel 4: Mechanik-Animation

1. Öffnen Sie die Datei robot_v11.blend aus dem 
Ordner 3D-Modelle in blender. 

2. Zur besseren Positionierung der Bones sollten 
Sie mit der Z-Taste und der Auswahl Wireframe
das Modell transparent machen.

3. Aktivieren Sie mit der linken Maustaste den 
mittleren Teil des Fußes des Roboterarms. Mit 
Shift + S öffnet das Snap-Menü. Curser to
Selected positioniert den 3D-Cursor zentral im 
gewählten Objekt. Jetzt müssen Sie das 
Koordinatensystem auf die gleiche Position 
setzen mit RMT und Set origin > Origin to 3D 
Cursor. 
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Beispiel 4: Mechanik-Animation

Zusammenfassen von Bauteilen mit „Join“.

4. Die ausgewählte Scheibe des Fußes und die Befestigung 
des Roboterarms (Entenkopf) müssen gruppiert werden, 
weil sie sich synchron bewegen sollen. Beide Teile mit 
LMT markieren, dann mit RMT Menü öffnen und mit Join
verbinden.

5. Das Koordinatensystem muss nun wieder auf den Platz 
des Cursors versetzt werden. Dies geschieht mit RMT + 
Set origin + Origin to 3D Cursor.

6. Nun muss das Koordinatensystem des ersten Armes in 
die Drehachse auf der Fußseite gesetzt werden. Auswahl 
Edit-Mode. Klicken Sie in das Zentrum der Armaufhäng-
ung. Jetzt sollte ein oranger Punkt in der Mitte sitzen. Mit  
Shift + S und Cursor to selected wird der Cursor dort 
platziert. Jetzt ist der Object-Mode einzustellen und mit 
RMT und der Auswahl Set origin + Origin to 3D Cursor 
verschieben Sie das Koordinatensystem ins Drehzentrum.
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Beispiel 4: Mechanik-Animation

7. Zusammenfassen der gesamten restlichen Bauteile mit 
„Join“. Eventuell muss nun das Koordinatensystem auch 
wieder in den Drehpunkt gesetzt werden. RMT und 
Auswahl Set origin + Origin to 3D Cursor 

8. Wählen Sie den Drehteil des Fußes aus. Mit Shift + S und 
Cursor to selected positionieren Sie den Cursor über 
dem Koordinatensystem des Fußes.

9. Shift + A öffnet das Add-Menü. Wählen Sie Armature
aus und es wird ein Bone an der Position des 3D-Cursers 
eingesetzt.
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Beispiel 4: Mechanik-Animation

10. Wechseln Sie in den Edit Mode. Um den Bone in Größe und 
Position zu verändern, aktivieren sie ihn und wählen die 
Taste G. Dann können Sie mit LMT Größe und Position von 
der Spitze aus verändern.

11. Wählen Sie den bestehenden Bone aus und drücken Sie die 
Taste E. Mit der Bewegung der Maus wird ein weiterer Bone
aus der Spitze des aktiven Vorgänger-Bones erzeugt. 
Bestätigen → LMT, Wiederrufen →RMT.

12. Bei aktiver Spitze eines Bones und der Auswahl der Taste G
können die Bones ausgerichtet und justiert werden. 
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Beispiel 4: Mechanik-Animation

13. Kontrolle der Bones in der Viereransicht. View + Area + Toggle Quad View
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Beispiel 4: Mechanik-Animation

Parent-Child-Beziehungen erstellen:

14. Zuerst sind die Abhängigkeiten der Bones zueinander einzustellen. Der Fuß nimmt bei einer Drehung alle 
anderen Teile mit. Deshalb starten wir bei dem Bone des Fußes. Der Bone des Fußes ist im Object-Mode zu 
aktivieren mit LMT. Danach ist der Pose Mode einzustellen und der Parent Bone mit LMT alleine zu 
aktivieren. Nun die Shift-Taste gedrückt halten und das Child (Folge-Bone) anklicken mit LMT. 
STRG + P öffnet das Set Parent to–Fenster in dem Bone auszuwählen ist. Dieser Vorgang ist mit dem zweiten 
Bone zu wiederholen, der jetzt als Parent des dritten Bones eingerichtet werden muss.
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Beispiel 4: Mechanik-Animation

Bauteile und Bones verbinden:

15. Den Object-Mode einstellen! Das Objekt (Z. B. Arm 
oder Fuß) anklicken mit LMT. Die Shift-Taste gedrückt 
halten und den zugehörigen Bone anklicken mit LMT. 
Bauteil und Bone müssen aktiv sein. Danach in den 
Pose-Mode wechseln und den richtigen Bone mit LMT
aktivieren! Der Bone hat nun eine türkisfarbene 
Silhouette.

16. STRG + P → öffnet das Set Parent to–Fenster → Bone
auswählen. Diesen Vorgang (Punkt 15 und 16) wieder-
holen, für alle Teile die animiert werden sollen. 

Denken Sie daran, dass alle Objekte mit einem der 
Bones verbunden sind, sonst werden sie nicht bewegt 
und verharren in der Ursprungsposition.
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Beispiel 4: Mechanik-Animation

Animationen einfügen:

17. In den Pose Mode wechseln: Klicken Sie den ersten Bone (Fuß) an mit der LMT an. Stellen Sie die 
Zeitleiste auf 150 Frames ein. 

18. Setzen Sie den Zeitstrahl auf 1 und geben Sie I ein, um das erste Schlüsselbild zu setzen.
Setzen Sie den Zeitstrahl auf Frame 30. 

19. Wählen Sie im Menü unter dem Mode-Fenster Rotate aus, um den aktiven Bone zu rotieren. 

20. Nach der Rotation mit der Maus geben Sie I ein, um das zweite Schlüsselbild zu setzen.
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Beispiel 4: Mechanik-Animation 

21. Animieren Sie nach dieser Methode jeden Bone im Roboterarm. 
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Join aufheben

Edit-Mode auswählen

Gruppe mit dem Rechteckumfahren

P-Taste drücken und unter dem Menü Separate → By Loose Parts klicken
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Beispiel 4: Mechanik-Animation

22. Geben Sie dem Roboter Farben, setzen Sie die Beleuchtung und erstellen Sie einen Film im mp4-Format.
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Beispiel 5: Kamera-Animation

Beispiel 5a: In dieser Übung soll die Kamera so eingerichtet werden, 
dass sie immer auf ein Objekt ausgerichtet bleibt. 

1. Öffnen Sie die blender-Standard-Datei mit dem Würfel und der 
Kamera.

2. Aktivieren Sie die Kamera und wählen Sie danach die Object
Constraint Properties aus. Wählen Sie im Menü Add Object
Constraint Track to aus. Danach wählen Sie unter Target Cube aus 
und aktivieren unter To: –Z und unter Up: Y, um die Kamera richtig 
auszurichten.

Nun sehen sie eine blaue Verbindungslinie zwischen Kamera und 
Koordinatensystem. Wenn sie jetzt die Kamera oder den Würfel mit 
der Maus bewegen, bleibt die Kamera immer auf den Würfel 
ausgerichtet.

Im nächsten Schritt wird die Animation der Kamera erstellt.
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Beispiel 5: Kamera-Animation

3. Stellen Sie die Frame Range auf 100 ein. Setzen Sie den Zeitstrahl auf 0.

4. Um den Start-Keyframe zu setzen, betätigen Sie die Taste I und wählen Sie im Insert Keyframe Menue
das Menü LocRotScale aus.

5. Setzen Sie den Zeitstrahl auf Frame 20, verschieben Sie die Kamera, öffnen sie wieder mit I das Insert 
Keyframe Menue und wählen sie LocRotScale aus. Testen Sie die Animation.

6. Wiederholen Sie diesen Vorgang alle 20 Frames, bis der 100. Frame erreicht ist.

7. Rendern Sie einen Film von der Kamerafahrt.
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Beispiel 5: Kamera-Animation

Beispiel 5b:

1. Öffnen Sie die Datei Druckluft.blend.

2. Arbeiten sie mit zwei Layern (Fenster rechts oben über der Bauteilliste). 
Im ersten Layer befindet sich der Druckluftmotor und die Lichtquelle. Löschen Sie die Kamera in diesem Layer.

3. Im zweiten Layer erzeugen Sie das Objekt Empty (Add > Empty > Plain Axes) und eine Kamera (Add > Camera). 
Das Achsensystem und die Kamera sind nun im Bauteil und schwer sichtbar. Markieren Sie die Kamera im 
Teilebaum und verschieben Sie sie vor die Maschine. Das Achsenkreuz bleibt an seiner Position. Aktivieren Sie 
die Object Constraint Properties.       Unter „Add Object Constraint“ wählen Sie „Track to“ aus. Richten Sie die 
Kamera mit To: –Z und Up: Y aus und wählen sie unter Target das Ziel „Empty“ aus. Jetzt sollte eine gestrichelte 
blaue Linie von der Kamera zum Fadenkreuz „Empty“ sichtbar sein (Siehe nächste Folie).

4. Animieren Sie die Kamera so, dass sie um das Objekt fliegt. Schalten sie beide Layer aktiv und schauen sie sich 
das Ergebnis in der Kameravorschau NUM 0 an. Die Kamera soll sich um den Motor bewegen und am Ende auf 
das Gegengewicht an der Pleuelstange zufliegen.  

5. Mit I und LocRotScale können Sie die Position auf der aktuellen Zeit des Zeitstrahls festhalten.
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Beispiel 5: Kamera-Animation

5b:
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Beispiel 6: Pfad-Animation

In dieser Übung soll ein Würfel einem Pfad entlang animiert werden. 

1. Öffnen Sie die blender-Standard-Datei mit dem Würfel und der Kamera.

2. Erstellen Sie ein Pfad-Objekt mit Add > Curve > Path.

3. Wechseln Sie in den Edit-Mode. Zoomen sie an den Pfad heran. Der Pfad 
hat fünf Punkte an dem Sie Änderungen vornehmen können. Verändern 
Sie die Positionen der fünf Punkte im Raum.

4. Weitere Punkte können Sie an den Enden des Pfads mit E erzeugen. 
Fügen Sie Punkte hinzu.

5. Wechseln Sie in den Object-Mode. Verkleinern Sie den Würfel mit S. 
Wählen Sie für den Würfel die Wireframe-Darstellung mit Z. 
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Beispiel 6: Pfad-Animation

6. Aktivieren Sie den Würfel und den Pfad. Mit Strg + P und Follow Path binden sie den Würfel an den Pfad.  
Achten sie darauf, dass der Würfel zu Beginn der Animation möglichst genau auf dem Anfang des Pfades 
sitzt. Die gestrichelte Verbindungslinie sollte möglichst klein sein.

7. Aktivieren Sie nur den Würfel. Schalten Sie unter View > Area > Toggle Quad View vier Ansichten ein, um 
den Würfel am einen Ende des Pfades zu platzieren.

8. Mit I öffnen Sie das Keyframe-Fenster. Wählen Sie LocRotScale aus. Stellen Sie die Frames auf 100 ein 
und setzen Sie den Zeitstrahl auf den 100. Frame. Nun platzieren Sie den Würfel an das andere Ende des 
Pfads. Mit I und LocRotScale setzen Sie den Keyframe. 

9. Testen Sie die Animation im Kamerafenster und erstellen 
Sie einen MP4-Film. 
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Beispiel 7: Pfadgeführte Kamerafahrt um ein Objekt 

1. Laden Sie den Druckluftmotor in blender.

2. Erstellen Sie einen Pfad der um den Motor läuft. 
Arbeiten Sie mit der Vierfensteransicht 
(View > Area > Toggle Quad View).

3. Verbinden Sie die Kamera mit dem Pfad, so dass  
sie um den Druckluftmotor fährt (Strg + P und 
Follow Path).

4. Richten Sie die Kamera auf den Druckluftmotor 
aus (Strg + T und Track to Constraint ).

5. Erstellen Sie eine Animation mit 150 Frames.

6. Rendern Sie einen Film. 
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Beispiel 8: Geführte Kamerafahrt um ein Objekt mit „Circle“

1. Laden Sie den Druckluftmotor in blender.

2. Erstellen Sie einen Circle über Add > Curve > Circle,
der um den Motor läuft. Stellen sie die Position des 
Circle über die Object Properties ein und setzen Sie 
danach die Camera möglichst nah an den Circle.

3. Arbeiten Sie mit der Vierfensteransicht um den 
Circle und die Camera optimal zu positionieren
(View > Area > Toggle Quad View). Die Richtung 
des Circle sehen Sie im Edit Mode.
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Beispiel 8: Geführte Kamerafahrt um ein Objekt mit „Circle“

4. Verbinden Sie die Camera mit dem Circle, so dass  sie um den 
Druckluftmotor fährt. Hierzu aktivieren Sie zuerst die Camera
und dann mit Shift + LMT den Circle. Danach binden Sie mit 
Strg + P und Follow Path, die Camera an den Circle.

5. Richten Sie die Kamera auf den Druckluftmotor aus, mit 
Object Constraint Properties und Track to. Dann legen Sie 
bei Target fest, auf welches Objekt die Kamera ausgerichtet 
wird. Danach muss bei To: -Z und bei Up: Y eingestellt 
werden. Kontrollieren Sie mit der Kameraansicht.

6. Erstellen Sie eine Animation mit 250 Frames. Hierzu müssen 
Sie die Standardeinstellung wie folgt verändern:  Wählen Sie 
die Object Data Properties bei aktiviertem Circle aus. Setzen 
Sie bei Path Animation den Wert bei Frames wie gewünscht 
auf 250.

7. Rendern Sie einen Film. 
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Frames

Die Anzahl der Frames, die benötigt werden, um den Pfad zu durchlaufen, wobei der maximale Wert für die 
Einstellung der Auswertungszeit definiert wird.

Evaluation Time 
Parametrische Position entlang der Länge der Kurve, an der sich das ihr folgende Objekt befinden soll (die 
Position wird durch Division durch den Wert der Pfadlänge bewertet). Standardmäßig ist sie mit der 
globalen Bildnummer verknüpft, könnte aber mit einem Keyframe versehen werden, um mehr Kontrolle 
über die Pfadanimation zu erhalten.

Follow
Die Objekte dazu bringen, sich entlang der Krümmung der Bahn zu drehen.
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Beispiel 9: Einstieg Texturen

1. Öffnen Sie eine neue Datei mit Würfel mit (Ctrl + N).

2. Schalten Sie um, in den Edit-Mode. Danach können Sie mit STRG + B die Kanten des Würfels noch etwas 
abflachen.

3. Nun stellen Sie zurück in den Object-Mode und wählen mit RMT + Shade Smooth.

4. Wenn Sie im Hauptmenü Texture Paint auswählen, dann erhalten Sie zwei neue Fenster.

5. Wählen Sie im rechten Fenster (oben rechts) die Ansicht Viewport Shading + Display render preview aus.

6. Danach wählen Sie in den Properties Active Tool and Workspace settings unter No Textures + „+“ eine Base 
Color aus. Nach dem Bestätigen mit ok, wird die Farbe sofort auf das Modell übertragen.

7. Anschließend stellen wir den Radius des Pinsels auf 15 Pixel ein und wählen eine Farbe aus. Damit bemalen Sie 
den Würfel.

8. Um den Würfel zu deformieren, wählen Sie unter Texture slots mit + ein neues Material und zwar Bump aus.

9. Durch die Einstellung des Farbreglers können Sie jetzt durch eine helle Einstellung, Schichten auf den Würfel 
abtragen und durch eine dunkle Einstellung Schichten auftragen.

10. Wählen Sie anschließend nochmals ein neues Material und dann Roughness aus. Nun stellen Sie durch den 
dunklen Ton die Oberfläche auf scheinend und durch den hellen Ton eine stärkere Rauigkeit ein.

11. Wenn sie im Fenster mit dem aufgeklappten Modell Ihre Änderungen sehen wollen, dann stellen Sie im mittleren 
Menü des Fensters unter dem Bildsymbol eine Darstellung Ihrer Veränderungen ein.
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Beispiel 10: Textur auf eine Maschine legen

1. Laden Sie den Druckluftmotor in blender.

2. Laden Sie im Hauptmenü mit + + General + Shading die geeignete Umgebung.

3. Im Properties-Menü die Material Properties aktivieren und mit Use Nodes die Nodes laden. 

4. Ein Bild als Textur mit add + Texture + Image Texture importieren. 
Im nun geöffneten Kasten „Image Texture“ 
unter Open eine Textur laden. 

5. Verbinden Sie den Texturkasten mit einer Linie
mit dem Principled-BSDF-Kasten, und zwar 
den Punkt Color am Texturkasten mit dem 
Punkt Base Color am Principled-BSDF-Kasten.

6. Durch einen Vertical Split, in dem Sie mit der 
Maus an die untere Kante des Hauptmenüs 
fahren und die RMT drücken, öffnen Sie ein 
neues Fenster. Im Editor-Type-Menü das 
Fenster auf UV Editor einstellen.
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Beispiel 10: Textur auf eine Maschine legen

7. Wählen Sie Im Layout-Fenster ein 
Bauteil aus und stellen Sie den Edit 
Mode ein. Klicken Sie den Button UV im 
gleichen Fenster. Im daraufhin 
geöffneten Menü ist nun Unwrap oder 
Smart UV Project auszuwählen. Die 
Struktur des Bauteils wird auf der Textur 
ausgebreitet. Mit dem Wechsel in den 
Object Mode wird die Textur schon auf 
dem Objekt angezeigt und kann jetzt 
noch im Kasten Principled BSDF 
verändert werden.

8. Exportieren Sie die Datei im glb-Format.

9. Binden Sie das Format in eine HTML-
Datei ein und öffnen Sie die Datei unter 
localhost (Apache-Server) im Chrome-
oder Firefox-Browser.
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Das glb-Format

GLB ist die binäre Dateiformatdarstellung von 3D-Modellen, die im GL-Übertragungsformat (glTF) gespeichert 
sind. Informationen über 3D-Modelle wie z.B. Knotenhierarchie, Kameras, Materialien, Animationen und 
Netze liegen im Binärformat vor. Dieses Binärformat speichert das glTF-Asset (JSON, .bin und Bilder) in einem 
binären Blob. 

Das GLB-Format vermeidet das Problem der Erhöhung der Dateigröße, das im Falle von glTF auftritt. Das GLB-
Dateiformat führt zu kompakten Dateigrößen, schnellem Laden, vollständiger 3D-Szenendarstellung und 
Erweiterbarkeit für die weitere Entwicklung. 
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XAMPP und Dreamweaver-Anpassung

Apache-Server: Download und Anleitung unter https://www.apachefriends.org/de/index.html

1. Nach dem Download und Entpacken von Xampp müssen alle Dateien im Verzeichnis .../xampp/htdocs
gespeichert werden. 

2. Aufruf im Browser mit: http://localhost/Meine_Datei.html

3. Der Dreamweaver kann so konfiguriert werden, 
dass er automatisch die Daten mit localhost
startet. Hierzu können Sie auch die Datei 
dw_xampp.ste unter dem Menü Site > Sites 
verwalten > Site importieren verwenden. Bitte 
konfigurieren Sie danach noch den Pfad, je 
nachdem, auf welcher Festplatte (z. B. c, d, …) 
XAMPP entpackt wurde, müssen Sie den Pfad 
unter Site noch anpassen. Wenn Sie die 
Schaltfläche mit dem Stift-Symbol anklicken, 
können Sie den Pfad anpassen.

https://www.apachefriends.org/de/index.html
http://localhost/Meine_Datei.html
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Beispiel 11: Textur, Shading, HTML5/glb

1. Erzeugen Sie zwei eigene Texturen und legen Sie diese als jpeg- oder png-Dateien ab. Erzeugen Sie eine 
Textur aus einem Bild mit einer Struktur wie Sand, Kies, Metall, Rost, Holz, Rasen. Die zweite Textur soll 
Personen, Gegenstände oder Objekte enthalten.

2. Verwenden Sie die beiden Texturen mit einer Maschine oder erstellen Sie aus den blender-Meshes
Objekte, auf die Sie die Texturen legen. Sie dürfen auch die Objekte aus den bisherigen Übungen 
verwenden.

3. Exportieren Sie ihre Übung im glb-Format.

4. Binden Sie die glb-Datei in eine HTML-Datei ein. Verwenden Sie die Daten, die Sie auf der Webseite 
https://technischeredaktion.com/3D_Animation/ unter dem heutigen Datum herunterladen können. 
Darin finden Sie:
- Eine HTML-Datei mit speziellen Styles für die Animation Ihres Modells (Nachname_Vorname_U11.html). 
- Eine JavaScript-Bibliothek (3d-model-bundle.js), die die 3D-Darstellung in der HTML-Datei erst 

ermöglicht. Diese müssen Sie mit der HTML-Datei verlinken.
- Eine ste-Datei zum Konfigurieren des Dreamweavers.

5. Erzeugen Sie drei Schaltflächen (<button>) in der HTML-Datei mit den Buchstaben X, Y und Z. Schreiben 
Sie ein JavaScript-Programm, das beim Klicken auf eine der Schaltflächen das 3D-Objekt um die 
entsprechende Koordinatenachse dreht. 

https://technischeredaktion.com/3D_Animation/
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Bsp: 12 FBX-Export (Erst nach der Unity-Veranstaltung relevant!)

Dieses Format wird hauptsächlich für den Austausch von Charakteranimationen zwischen Anwendungen 
verwendet und wird von Anwendungen wie Cinema4D, Maya, Autodesk 3ds Max, Wings3D und Engines wie 
Unity3D, Unreal Engine 3/UDK und Unreal Engine 4 unterstützt.

Der Exporter kann Mesh-Modifikatoren und Animationen in das FBX einbinden, sodass das Endergebnis 
genauso aussieht wie in Blender.

Quelle: https://docs.blender.org/manual/en/2.80/addons/io_scene_fbx.html

https://docs.blender.org/manual/en/2.80/addons/io_scene_fbx.html
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Bsp. 12: Export im FBX-Format für Unity (VR)

1. File → Export → FBX

2. Wählen Sie nur die benötigten Objekttypen aus (z.B. Mesh)

3. Wenn Sie keine Animation übernehmen wollen, dann deaktivieren Sie
„Bake Animation“

4. Starten Sie Unity und importieren Sie das Modell mit Assets → Import New Asset

5. Verschieben Sie das Objekt vom Assets-Bereich in die Bühne.

6. Jetzt versehen Sie das neue Objekt auf der Bühne mit einem 
a) C#-Programm,
b) einem Box-Collider (Component→ Physics → Box Collider) und
c) einem Rigidbody (Component→ Physics → Rigidbody).

7. Nun deaktivieren Sie im Inspector bei Rigidbody „Use Gravity“ und aktivieren 
unter Constraints – Freeze Position die Y-Koordinate und
unter Freeze Rotation die X-, Y- und Z-Koordinate.

8. Testen Sie, ob das Modell die erwarteten Reaktionen zeigt nach dem Sie
die Anwendung gestartet haben.  
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Bsp. 12: Export im FBX-Format für Unity (VR)
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Bsp. 12: Animation aus Blender in Unity übernehmen.

In Unity

1. Animator hinzufügen über „Add Component“

2. Animator Controller hinzufügen mit „Create Animator Controller“

3. mit einem Doppelklick in den Assets den „Animator Controller Editor“ öffnen.

4. die Animation aus dem Asset-Ordner in den Editor ziehen.

5. das Animationsobjekt auf der Bühne aktivieren und im Inspector unter Animator Controller den Animator 
Controller eintragen.
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Bsp. 12: Animation aus Blender in Unity übernehmen.
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Bsp. 12: Unity: Editor für 
Animation

Im Asset-Bereich das animierte Modell 
aufklappen und dann das Animationssymbol

Klicken.

Im Inspector dann mit dem Klick auf „Edit…“ das

hier angezeigte Fenster öffnen.

In diesem Fenster dann
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Bsp. 12: Unity: Editor für 
Animation

In diesem Fenster dann die im Bild dargestellten 
Einstellungen vornehmen, damit die Animation

Im Loop ausgeführt wird.


